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LottoChecker-X
Manual

Introduction

Thank you very much for downloading LottoChecker-X. This little manual is meant to show you how to use LottoChecker-
X, just in case you could not find out yourself. This text describes - with screenshots and such - how to use LottoChecker-
X.

But first a little word on what it is : LottoChecker-X is a tool to control and follow up your Lotto results. Just enter the
winning numbers and you know your profits or losses - immediately. No more manual counting necessary.
LottoChecker-X keeps a history of all the drawings your form participated in. At the end of the road, you will know the
exact price of playing Lotto.

LottoChecker-X does not do any statistics or optimization or guessing. We are pretty sure every possible combination has
an equal chance in Lotto, so trying to guess with pseudo-statistical nonsense is, well, nonsense. That is how we see it at
least.

One last thing : if you play different numbers every drawing, LottoChecker-X is not for you. You'll spent more time
entering (or clicking) your numbers into LottoChecker-X than you win by letting LottoChecker-X do the counting.

Good luck!

Starting Up

You start LottoChecker-X by double clicking its icon in the finder. Another approach would be almost
criminal, no?

LottoChecker

The windows that opens should be familiar - at least when you are a Belgian. The window looks like the Belgian Lotto
form. So if you play in Belgium, you can start crossing numbers right away. Others should take a trip to the preferences.
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This is how LottoChecker-X looks like when you start it up for the first time.

So if the lay-out shown above is not what you are used to, you must open the preferences.

Preferences

The preferences dialogue allows you to change the look - and a little more - of the form to the way Lotto is played in your
country. The preferences dialogue contains a lot of tab-sheets. We'll walk through them one by one :

Resgister
eon Prefarences

~—{“Register| Lay-Out Profits&Costs = Rules —

Username : Not Registered

Password : Unknown

( Buy (108) from Kagi )

( Cancel ) 0k

Unregistered versions of LottoChecker-X only accept 2 draws per form. To do away with this limitation, you should buy
a user name and a password. So keep your credit card at hand and push the ‘Buy’ button. This will take you to the Kagi
webshop where you can order LottoChecker-X. A valid username-password combination will be mailed to you within 48
hours. (In July-August, this could take longer due to holidays).
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Lay-out

This second page allows you to change the look of the form. Below are settings to make the form look like the one from
Holland :

8enn Preferences

—' Register I-—haww Profits&Costs =~ Rules '—

#Numbers Per Game : 45
#Colums per Game ; 5
#Crosses Per Game ! B
#Cames per Form : 10
| Show Super Nr

E Show Jackpot Color

Whatever you enter her influences how the playing field will be drawn
and what numbers {or colors) vou must entar for every draw.

( Cancel ) m

The different fields and options on this dialogue have the following meaning :

- #Numbers Per Game : out of how many numbers can you choose. In Belgium, you can choose your numbers out of
42 possible numbers. In Holland, there are 45. Bigger countries have 49 possible numbers.

- #Columns Per Game : (Game is just another word for Grid here) : how many columns does every grid have. In
Belgium, every grid has 6 columns, in Holland 5 and in France 7 - | think Germany and the UK have the same lay-out
as France.

- #Crosses per Game : How many numbers are you allowed to cross? This is normally 6. Some countries do offer the
possibility to set more crosses for a premium price.

- #Games Per Form : How many grids do you play per form?

- Show Super Nr. : In some countries, you can win a jackpot if you not only have 6 crosses in one grid matching the 6
balls drawn, but also a 7 number - the so called super number - matching a number that is pre-printend on your form.
If that is the way lotto is organised in your country, you should check this option. This will allow you to enter the super
number on the form and on every consecutive drawing.

- ShowJackpot Colour : This is similar to the super number. In stead of a number between 0 and 9, you can now choose
1 out of 6 possible colours. This system is used in Holland.

When you entered the numbers shown above in the Lay-out tab of the preferences dialogue, the main window should
look like follows :



-
860 Naamloos
illzlf=1[+1[5 [zl ][+ 1[5 illz)f= ]+ 1[5 1 A0 E BB OB lz)fz 1415
8|7 ][a 0 5|[7 5 ][=1[ic 8|7 M2 ]2 ][0 & 5 |[2 o a7 I[5]=lio 8|7 [z =0

i1j2{113fji4]{15 11 jj12)|i3fji44115 111213415 11jji2jiafji4115 1112|113 jji4)|15 1121131415

21 ||221123 {24 |{25 21|22 |23 |24 }125 21 j|22}123 124 ||25 21122 []23[j24 125 21 J|22}|23 [|24 |25 21122 |23 |[24 |{25
26127 ||28]{29 |(30 26|27 ||28 [j23 130 26|27 |[28 [129 |30 26|27 |28 [j23 130 26|27 ||28 [|29 |30 26|27 |28 {29 |{30
31|32 ||33](34 |{35 31§32 J|33 [|34 135 31|32|{33 134 |35 31132 |33 134 135 31)|32||33 |34 |35 311132133 1{34 |{35
36|37 |38 {32 |(40 36|37 |38 |j33 (j40 36|37 (38 {32 |40 36|37 ||38|j3a (|0 36|37 |38 |32 |40 36137 ||38(33 |(40
41 [l42]{a3 {44145 41 |42 |43 [ja4 145 41 [|42 {43 [ja4 145 41|42 [[43|ja4 145 41 142 ]j43 Jja4 |45 41142 |45 |34 ll45

1i[2z][+][5 1 HBBOE i[2)z][+][5 1 i[4)E] | ] @ reen
8 (7[5 ][= |[io 67 &)= 1o 8 [7 = ][=][ic 5 a)3]ie] | [] @ hooe
IEEDENIEEDEMIEEDNENDEEDESER E
DEEEDMEEDEDNDEDEZNEEDE DR Geal
21)lzz)a)les)es] | [illzzllea)eslles] | [a)le2)aliealles] | Eillellealeslles] | ] @ paars
zo)le7)a)lea)a) | [esllez)lee)zs)ze] | [esller)allesllEe] | Eelzllsleslec] | (] @ omne

a1 ||32ll3a)|z4|l3s5] | |31]|z2]|3a]la4]la5 31 |[az|3alla4]las]| | |31lis2||33]l34]l35
s6||a7|lza][z9lls0] | |3sllaz||zallas]l+o s6lla7|l3allaallso] | |3slls7||zallaa]l40
41 |l42llaa)ls4]ls5] | [a1ljs2]fsaljs]lss a1 |l42lfaallaslss] | |a1lla2||salfs4]l4s

£€0,00 @

This lay-out is the one that is used in Holland.

Profits&Costs

Next tabsheet of the preferences dialogue is called ‘Profits&Costs’. This is where you can enter what the projected profits
are, and what the costs of playing are.

Standard Profits
8nn Preferences
! Register Lay-Out | Profits&Costs | Rules —

More Profits = Costs }—-.

Nr Only + Auxiliary Nr  Use
3 Ok : 2,50

4 Ok : 25,00

50k: 1.000,00 5.000,00

6 Ok: 1.000.000,00

B O®AOO

Jackpot : 50.000.000,00

( Cancel ) EsBkd

Not all combination of matching numbers and auxiliary number result in different profits. In Belgium, the Auxiliary
number is only considered when you have 5 matching balls. Other countries have a different profits for every
combination of matching numbers with and without matching auxiliary number. So check all the combinations that apply
in your country, and enter the expected profit. The screenshot above shows a system where the profits for 3 matching
balls are always 2,5, regardless of the fact that you have or have not a matching auxiliary number. The profits you enter
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here will be copied to every drawing. You can override them per draw.

More Profits

In most European countries, you only have to mind the standard profits. In Holland however, there are a lot more different
profits possible. There exist different profits for 3, 4, 5 and 6 matching balls, 3, 4, 5 matching balls plus the auxiliary
number, 3, 4, 5 matching balls plus a matching colour and 3, 4, 5 matching balls plus a matching colour plus a matching
auxiliary number. If you have 6 Matching balls plus a matching colour, you win the jackpot.

8enn Preferences |

—' Register  Lay-Out | Profits&Costs | Rules —
- Standard Profits F—MW Costs -

+ Color Ok
+ Color Ok Use + Auxiliary Nr. Use
3 4,00] [ 10,00 [
4 30,00 [ 300,00 |
5 1.000,00 [ 100.000,00 !

( Cancel ) @-—vﬂﬁ—;

The expected profit for all these winning combinations can be entered in the ‘More Profits’ tabsheet. You have to check
the ‘Use’” checkboxes as well if you want LottoChecker-X to consider these profits.

Costs
Here you enter what it will cost you to play. There are 3 costs you can enter (leave them to 0O if they do not apply):

- Cost for Game : The price for one grid.

- Cost for Colour. : The price to cross a colour. (If any).

- Cost for Super Nr. : The price to play the super number (if any)
The dialogue looks like this :
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8enNnn Preferences

—{ Register  Lay-Out | Profits&Costs | Rules }—

- Standard Profits = More Profits HW}-

Cost per Game | i_ I D,Sﬂi
Cost For Color : 0,00
Cost For Super Nr: 0,00

Costs for playing.

Rules

8enn Preferences

—{ Register  Lay-Out  Profits&Costs w—

Jackpot If 6 + [ Auxilary Number
! Super Number

W Color

Here, you can set the rules to determine if one won the jackpot. If the
Jackpot’ checkbox (below the "Use’ header] on the 'Profits&Costs” tab is
not checked, there will be no checkable options on this page.

(Cancel :] E

On this last page, you must enter the rules that apply in order to win the jackpot. Cross any additional (besides 6
matching balls) condition that must be met to win the jackpot.
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Playing your game - Setting Crosses.

Ooverview

Once finished with the settings, you can start entering your lucky numbers. When starting LottoChecker-X for the first
time, a new empty form is created according to the current preferences. As long as you do not touch that empty form,
you can update the preferences. The form will be updated accordingly. Mind you however : as soon as you enter even
one tiny cross, the lay-out of the form will be frozen. A form that was updated keeps its settings : it will not follow any
preference change! This allows you to have a Dutch, an English and a Belgian form open all at once. So it is important to
have your settings right before you start entering crosses. And setting crosses is easy : just click!

Step By Step

To start a new game, just select ‘File->New’ from the menu.

. ®N

New b
Open... % B0
Open Recent |
Close W
Save 3S
Save As... {r3S
Revert

Page Setup... T¥P
Print... HP

A new form will be created. The looks of that new form are determined by whatever you entered in the preferences
dialogue.
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Entering Crosses
To enter a cross, just click on the number you want to play. A blue cross will appear, just as if you had drawn a cross with
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a pen.
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Erasing Crosses
To erase a cross, click on the crossed number. The cross will disappear.

Select a colour
This is just the same as selecting a number. Click!
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Changing Colours
Just click another colour. The colour that was selected will be unselected automatically.

Erase a colour
Click on the colour that was selected, and the cross will disappear.

Error messase

You are not allowed to cross more numbers than you set in the preferences. If you try to set a seventh cross when the
preferences state that only 6 crosses are allowed, you get the following error message :

Error!

You have crossed as many numbers as you are

allowed for this game.

Entering Drawings

Any time there is a new drawing, you must enter the winning numbers into LottoChecker-X. If you ever happen to have
more than 3 matching numbers, you can enter the corresponding profit as well. You could enter all the profits for every
game as well if you want to do so, but LottoChecker-X does not need that information to calculate the total profit as long
as you only have 3 or less matching numbers. The profit for 3 matching numbers is mostly fix (in Belgium it is : 2.5 €), so
the amount copied from the preferences is the right amount.

If you have more than 3 matching numbers and you do not enter the exact profits, LottoChecker-X will use whatever you
entered in the preferences.

Create a new drawing
There are 2 ways to create new drawings :



The long way

- Just click the round button labelled ‘Res’. It will turn blue and the result drawer will open. Another way to
open the result drawer is via the key-combination ‘@+R’. Selecting ‘Toggle Results’ from the Window menu does the
trick as well.

=
- Next, click on the little button labelled ‘+’, or type ‘@+K’. The menu item ‘New Result’ from the ‘Edit’ menu
is a good alternative.

The short way
Press ‘@-+K’ with the result drawer closed. This will open the drawer and create a new, empty, result.

Attention

Once you created a drawing, you are not allowed to modify the form anymore. So if you create a drawing and
LottoChecker-X thinks the form is not completely filled yet (no 6 crosses in each grid), you get the following warning. Just
press yes to ignore it :

Question

Are you sure you want to create a drawing? You are
not allowed to modify the form once you have
created a drawing, and it looks to me as if the form
is not yet completely filled.

(N ) S

Keep in mind that forms for which drawings are entered cannot be modified anymore.

Entering the numbers

Just start typing. While you type, the numbers will be ordered automatically. This is very handy, unless you are modifying
an existing game. In that case you must be careful to enter your numbers in the right position.

Date Result
29/12/03 ~5.00 h
s [[13 [123 [|24 |34 |40 7

r
. Blue M

1 29/12/03 | Result: (€ 5,00)

&
| _— 4

The red ‘€5’ you see on the screenshot above is the total profit (or loss in this case) for the selected game. The number
you see on the bottom left of the main window is the total profit (or loss) for all the drawings.

Entering Profits

To calculate the exact result, LottoChecker-X needs to know the exact profits. As long as you have three or less matching
balls, LottoChecker-X knows. When you have more than 3 matching balls, you should enter the profits manually.
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= bue Resilt. raw e " re Profits —
28/12/03 =5.00 3 2__,_5ﬂ- 3+
4. 25,00 44
5: 1.000,00 5.000,00 5+
6: 1.000.000,00 64
= Jackpot : 50.000.000,00

Which fields are accessible depends on the settings of the preference panel.

More profits

If you live in a country having complex lotto rules, you might have to enter even more profits on the ‘More Profits’ tab.
Here you can enter the profits you get when you have 3, 4 or 5 matching balls plus the colour plus (optionally) the
auxiliary number.

Reading the result

While you enter the results, you may notice that the background colour of some numbers on the main window changes.
The calculated result will be updated while you type as well. Below is an overview of the different possibilities.

- | : A drawn number you did not cross.

- |u| : A drawn number you did cross. You want 6 of these!
- | : The auxiliary number. Drawn but not crossed.

- . : The auxiliary number. Drawn and crossed.

1] :
- : An ordinary number. Drawn nor crossed.

Oh yeah, there is one more thins...

Good luck while playing Lotto. And keep in mind : The best way to maximize your profits is by not playing. So not
playing for two weeks will earn you enough to buy LottoChecker-X. Just do it!.
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